Content
Welcome ..................................................................................................................... 5
About a:design2 ....................................................................................................... 7
License (Full version) ............................................................................................... 7
Differences between Basic and Plus version .......................................................... 8
The help system ....................................................................................................... 11
Use the help ............................................................................................................. 11
Navigation in the help system .................................................................................. 12
a:design2 .................................................................................................................. 13
Installation ............................................................................................................... 13
Installation process .................................................................................................. 13
System requirements .............................................................................................. 14
Work with a:design2 ............................................................................................... 15
Text fields ................................................................................................................ 16
Internal and graphic fonts ....................................................................................... 16
Variable line spacing ............................................................................................... 17
Unicode text ............................................................................................................. 17
Barcodes ................................................................................................................... 18
Internal and graphic Barcodes .................................................................................. 19
Autocode Barcodes .................................................................................................. 19
Image import ........................................................................................................... 20
Increase of the image quality .................................................................................. 20
Import opportunities ............................................................................................... 21
Program interface ................................................................................................. 22
The main interface ........................................................................................................... 22
Menu bar .......................................................................................................................... 23
The ruler ............................................................................................................................ 24
The status bar .................................................................................................................... 24
MDI - Documents / main form .......................................................................................... 25
The object browser .......................................................................................................... 26
The symbol bar .................................................................................................................. 27
Object properties dialogs ............................................................................................... 30
General ............................................................................................................................. 30
Simple forms ...................................................................................................................... 32
Text .................................................................................................................................. 32
Barcodes ............................................................................................................................ 34
Images ............................................................................................................................... 35
Variables ........................................................................................................................... 37
Counter .............................................................................................................................. 38
Date fields ......................................................................................................................... 39
Formulas ............................................................................................................................. 41
Free variables .................................................................................................................... 42
Shift codes .......................................................................................................................... 42
Common variables .......................................................................................................... 43
RS-Fields ........................................................................................................................... 44
Audit Codes ........................................................................................................................ 45
Printer dialogs ................................................................................................................... 47
Printer configuration ........................................................................................................ 48
Printer Setup ..................................................................................................................... 48
Font setup .......................................................................................................................... 49
Welcome to the a:design2 help system.

On the left navigation bar you will find all help topics, which contains in a:design2. On the various topics will take you directly from a:design2, by pressing the F1 - Press. Further details about using the help system, see the following section „Use the help“.

For further more information or questions about a:design2 please contact:

**Allen Coding GmbH**
Friedrich-Bergius-Ring 30
97076 Würzburg
Germany
E-Mail: support@allencoding.com
Web: [http://www.allencoding.com](http://www.allencoding.com)

Tel.: +49 (0)931-25076-0
Fax: +49 (0)931-25076-50
About a:design2

Congratulations on the purchase of a:design2. a:design2 enables easy and intuitive creation of thermal transfer labels.
It was specifically designed for the needs of Allen Coding NG series and Allen Coding NX series and supports the printing on windows printer driver.
This means you can control any printer for which you can obtain a compatible windows driver from the manufacturer.

We continue developing a:design2 to extend it with more functions and print systems. You can check the latest version on our homepage www.allen.coding.com. Updates of version 2 are available for a free download or you can request a CD with the latest version.

If the help system can not help enough or if you have urgent questions please contact our support team (see contact).
Have fun creating your labels.

License (Full version)

Opportunities to acquire a license for a:design2.
You can obtain a license for a:design2 via E-Mail, telephone or fax. This license is valid only for the PC, for which the license was issued. To acquire a license you need the hardware key. This identifies your PC and the registry key which you receive by Allen Coding. To register a:design2 and request a unique key for your PC click on "Help -> Register". In the first textfield there is the hardware key which you need for the activation. You can send this key to Allen Coding by different ways:

**License acquisition via e-mail**

Click on these button to open your default e-mail program. The e-mail contains automatically all information. Additional you can append some information. After sending the e-mail you will get a answer by Allen Coding GmbH.

**License acquisition via telephone**

Call the telephone number which is displayed in the dialog. You have to tell the Allen Coding employee the hardware key.

**License acquisition via Fax**

Click on this button to request a license via telefax. The program generates a text file which you can print and send to Allen Coding. The telefax number is displayed on the dialog.

**Activation key**

In case of a successful activation you get an activation key. This you have to enter in a:design2. Click on 'Register' to conclude the registration. You get a success message and the application close itself. If the key is incorrect check the key on potential typing errors and try it again.

---

**Differences between Basic and Plus version**

**Differences between Basic and Plus version**

---

**version**
Differences between BASIC/PLUS version

By default, a:design2 is running in a BASIC version that does not include special features such as database functionality, Barcode/GS1 Wizards and PDF Wizards.

<table>
<thead>
<tr>
<th>Features</th>
<th>a:design2 BASIC</th>
<th>a:design2 PLUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating languages</td>
<td>German, English, Spanish, French, Italian, Portuguese, Swedish, among others</td>
<td>German, English, Spanish, French, Italian, Portuguese, Swedish, among others</td>
</tr>
<tr>
<td>WYSIWYG-print layout</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>multi-document</td>
<td>-</td>
<td>✓</td>
</tr>
<tr>
<td>„drag and drop“ functionality</td>
<td>print image and objects</td>
<td>print image and objects</td>
</tr>
<tr>
<td>Unicode support</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>data sources</td>
<td>fixed content, input variables, global variables, date, time, counter, shift code, among others</td>
<td>fixed content, input variables, global variables, date, time, counter, shift code, among others</td>
</tr>
<tr>
<td>database functions</td>
<td>-</td>
<td>Excel, Access, ODBC, SQL</td>
</tr>
<tr>
<td>GS1-Barcode wizard</td>
<td>-</td>
<td>for GS1-128, GS1-Datamatrix and GS1-QR Code</td>
</tr>
<tr>
<td>printer fonts</td>
<td>additionally installed fonts on the printer can be installed for true WYSIWYG</td>
<td>additionally installed fonts on the printer can be installed for true WYSIWYG</td>
</tr>
<tr>
<td>and Windows fonts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDF import wizard</td>
<td>-</td>
<td>✓</td>
</tr>
<tr>
<td>graphics / images / logos</td>
<td>JPEG, BMP, PNG, TIFF, GIF, WMF, among others</td>
<td>JPEG, BMP, PNG, TIFF, GIF, WMF, among others</td>
</tr>
<tr>
<td>regions print</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>copy and paste objects</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(in PLUS version also between multiple labels)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>mark objects as “not printable“</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>lock / unlock objects</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>invert objects</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>rotate objects (90° steps)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>align / arrange objects</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>zoom view</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>supported „Allen Coding TTO printer“</td>
<td>NGT series, XL-series, LTi / LTc, NX-series, among others</td>
<td>NGT series, XL-series, LTi / LTc, NX-series, among others</td>
</tr>
<tr>
<td>Windows printer</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>label export to image file</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>label import (. imp file from JDS7)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
The help system

Use the help

This help entry describes the use of the help system in a:design2. You should read this chapter before you use the help to get as fast as possible the information you need.

Call the help
To open the help system press the F1 key. Depending on the dialog you work with shows a:design2 the help. Alternative you can click on the ”Help Button” which is available in many dialogs.

Printing of the help pages:
If you want to print a help page you only have to click on the printer symbol. You can print single pages or complete chapters.

Navigation in the help system
In the left screen is the navigation bar. Here you can call the help themes. The help contains several chapters with more entries.
A chapter is presented by a book symbol. If you click on the “plus” or double click on the chapter name the single help pages are displayed.
With a click on the help page it will be displayed on the right site. For further information please read the help page ”Navigation bar” in the chapter “Using the help”.
The help system can be controlled like a HTML-browser (e.g. Microsoft Internet Explorer).

The “back” button you open the previous opened help page. After clicking the “back” button you can reopen the old site with the “forward” button.

Navigation in the help system

This help entry describe the usage of the navigation bar in this a:design2 help system.

Furthermore you can set the navigation bar of the help system in three different modes. To switch a mode click on a tab:

**Mode help topic:**
Every subject is sorted in a tree view by its chapter and entries. This is the default mode.

**Mode index:**
Here you can search for keywords in single topics. There is more than one result possible.

**Mode search:**
This mode executes a full text search in all help topics. Enter your keywords in the text field. Once you click on one of keywords in the list the help topic is called.

The help system can be controlled like a HTML-browser (e.g. Microsoft Internet Explorer).
Installation

Installation process

Index
This help entry describes the a:design2 setup

**Installation of a:design2**

Before you start with the installation please ensure that your aim system contains the minimum requirements of a:design2. Should this not be the case maybe a:design2 works on your pc with performance problems.

To start the installation please insert the a:design2 installation CD in your pc drive. Choose the menu item "setup".

Alternative: If you get the setup by e-mail or via web download please start the setup.exe.

Please follow this single installation steps.

1. **EULA**
   At first you read attentive the EULA (End user license agreement). If you agree to the conditions confirm with "next".

2. **Installation path**
   Choose the destination directory which you want to install a:design2. General this directory for operating systems >=Windows 7 is "C:\Program Files (x86)\Allen Coding\aDesign2". If you do not agree you can choose a new directory.

3. **User setting**
   You can determine whether a:design2 will be installed for every user or just for the logged in windows user. You can decide whether you register your a:design2 now or later.

The installation should only take a few minutes.

**Note**

To use a:design2 without problems you need the .NET Framework 3.5 before you install a:design2.
If you use Windows Vista or higher you already have installed .NET Framework 3.5.

**System requirements**

The requirements to the pc system to use a:design2 without problems
System requirements

Windows XP Service Pack 2 or
Windows Vista
Installed .NET Framework 3.5

Hardware requirements
- One CPU with at least 1.0 GHz processor speed
- At least 512 MB RAM
- 100 MB free hard drive space (.NET Framework is already installed)
- A supporting DirectX graphic card
- A monitor with a resolution of at least 1024x768 points
- CD/DVD-ROM drive
- Mouse and keyboard as input device

It is possible that a:design2 runs on worse pc systems. However performance problems may occur. Enough free RAM is very important for a quick program using.

Work with a:design2

Index

- Text fields
- Barcodes
- Image import
- General
Text fields

When to use which font?

a:design2 and other label design software differentiates between print internal and graphic fonts.

<table>
<thead>
<tr>
<th>Print internal fonts</th>
<th>Graphic fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print internal fonts are font types which are installed on the print system and can be used for Autocodes (counter, date, variables). Internal fonts need to be used if you have a field on your label which changes during the print. This can be a counter, a date or a variable.</td>
<td></td>
</tr>
<tr>
<td>These are all Windows TrueType fonts which the printer has not installed. If you create a text with such a font you have to send this text as graphic to the print system. Graphic fonts can be used for all fields which do not change their value after the label creation.</td>
<td></td>
</tr>
</tbody>
</table>
Variable line spacing

You can change these settings in the text properties -> Others -> line spacing

This option allows you to set the line spacing of a text field. The default line space is 100 % and depends on the font and your system settings. The value range is between 30 % and 250 %. If you set the line space the text will be adjusted automatically. This setting can be used for graphic and print internal fonts and are stored field specific.

Unicode text

Input of Unicode text

Unicode is an international font default which joins all character of all language cultures to one coding. Unicode fonts codes 65,536 characters on 17 levels.
If you use an international font such as Cyrillic or Chinese characters it is important that the selected font supports unicode. Otherwise the character will be replaced by an alternative character. Since Windows 2000 offers Microsoft the character map which you can use to enter international fonts. a:design2 supports unicode fonts like western fonts if the font and the aim system support this coding.
With this can you choose, copy and insert Unicode characters in a:design2. It is recommended to add the character map as external program to have quick access.

Barcodes

Barcodes

Index

- Internal and graphic Barcodes
- Autocode Barcodes

Internal and graphic Barcodes
**Internal and graphic Barcodes**

Barcodes in combination of Autocodes

a:design2 supports many barcodes. Whether a barcode is transferred as print internal barcode or graphic barcode depends on the printer driver. In the properties dialog of a barcode is beside the barcode preview an icon which shows you how the barcode will be transferred. Maybe the printer supports a barcode but it does not support the inverted one. Choose the option "Invert barcode" to convert a barcode to graphical code.

**Print internal barcode:**
The barcode is drawn on the label by the printer. So can occur problems if the aim system displays the barcode different. Print internal barcodes have the advantage that they can be variable or counting. This allows the change of barcode values during printing.

**Graphic barcodes:**
Graphic barcodes are drawn by a:design2 which are transferred as graphic to the aim system. These barcodes cannot be changed after the transfer. But they have the advantage that the user is absolute free in designing barcodes. You can create barcodes which the aim system does not support.

**Autocode Barcodes**

Barcodes in combination of Autocodes

In a:design2 you can design barcodes as variable or counting barcodes. Theoretically is this possible for every barcode type but many print systems are supporting only ASCII code barcodes like Code39 and Code128. If you choose a barcode which cannot be used as an autocode, you will get a warning message.

To create a variable barcode choose in the tool bar:

-> Create a barcode
Click on the label
Choose variable text or counter

For more information read the help entries Variables and Counters.

**Note**
The rules above also apply to variables or counting bar codes.

---

**Image import**

To gain optimal quality of your label please regard following criteria while importing images:
Use images which were created with a high resolution. The resolution of the print system is 300 dpi.

Adjust the threshold value in the image properties dialog so that the details are displayed better.

The size changing of an image affects to the image quality.

---

**Note**

Try to avoid the JPEG format because the quality suffers of the compression.

---

**Import opportunities**

**Image import tool**

Choose the image import tool and click on the label. A file selection dialog show you images for a choice.

**Drag & Drop**

Drag a image from your operation system to a:design2.

**Copy & Paste**

You can also use Copy & Paste to import a image.

**Supported image files**

<p>| Joint Picture Expert Group | *.jpg |
| Windows Bitmap             | *.bmp |
| Graphics Interchange Format| *.gif |
| Portable Network Graphics  | *.png |</p>
<table>
<thead>
<tr>
<th>Icon Format</th>
<th>*.ico</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tagged Image File Format</td>
<td>*.tga</td>
</tr>
<tr>
<td>Device Independent Bitmap</td>
<td>*.dip</td>
</tr>
<tr>
<td>Windows Meta File</td>
<td>*.wmf</td>
</tr>
<tr>
<td>Windows Enhanced Metafile</td>
<td>*.emf</td>
</tr>
<tr>
<td>Exchangeable Image File Format</td>
<td>*.exif</td>
</tr>
<tr>
<td>ZSoft Paintbrush</td>
<td>*.pcx</td>
</tr>
</tbody>
</table>

Program interface

The main interface

The menu bar
Menu bar

**Order by function**

Single menu points in the overview:

**File**
Includes all operations which belongs to the current edited document like New, Save, Close, Export to, ...

**Edit**
All operations for manipulating the current selection in the workspace.

**View**
All functions related to presentation of the label and the program interface

**Objects**
All tools to create new objects of the label are capsuled in this menu. In addition all operations for alignment and rotation of objects are included.

**Windows**
Offers base functions for selection of all opened document windows - Arranging tile horizontal, tile vertical and cascading is also offered.

**Extras**
Provides access to functions which fit in no other menu:
- Protect document - You can set a password for your document
- External programs - Display your external embedded programs in a submenu.
- Options - Shows the program options
Help
Offers functions like showing the help and registration of the application.

The ruler

The ruler is on the left and top of the page of your label. It displays the width of your label in millimeters.

Zoom function
The ruler has some functions which help you to create labels.

1. The top ruler is divided in two halves. Double clicking on the right half of the ruler enlarges your label. Double clicking on the left half of the ruler reduces your label.

2. A right click on the top ruler opens a popup menu which provides you different zoom options.

The status bar
Status bar of the a:design2 - bottom part of the main form

The status bar shows you information about:

**The name of the chosen printer:**
The name of the printer which is used for the current label. The name can be changed anytime in the printer configuration.

**Connection of the printer:**
Display the network connection of the printer with which you can reach the printer. This can be an IP address or a string of a serial interface. You can change the connection in the printer configuration.

**Mouse or object position:**
This information only appears if you work with a label. If you select an object you can see the position, width and the height of it. Otherwise you can see the x and y position of your mouse cursor.

MDI - Documents / main form

a:design2 is a so-called MDI application (Multiple Document Interface). You can open as many documents within an a:design2 instance. In order not to lose track of opened documents you can switch the view of your documents with selecting the menu item "Windows".

Optional it is possible to arrange your documents as:

- **Tile horizontal**
- **Tile vertical**
- **Cascading**

If you close the main application all documents will be closed automatically. A memory request is previously
displayed. Despite the MDI ability of a:design2 you can run multiple program instances.

The object browser

The document browser provides information about the objects located on a label.

Object browser of a:design2 - right part of the main form

The objects are categorized into the different types of objects. Automatic codes have their own Tab. Directly behind the object category is the number of existing objects in your label. By clicking on the plus sign to expand a category and you can view its properties.

Changing object properties
Through the expansion of a node object you can view its properties such as names, positions and width. These properties can be changed directly in the object browser by double clicking on the relevant property. Alternatively you can press the F2 key. After you have entered the new value you can confirm with RETURN. The new value is now being taken.

**Shutdown of the document browser:**
If you do not need the object browser you can always switch him in "View -> Document Browser" on or off.

---

**The symbol bar**

**The symbol bar**

The most important program functions for direct access

**General symbol bar**

This offers general options for the application and the label objects. It is recommended blending in this symbol bar.

<table>
<thead>
<tr>
<th>Symbol meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎨 Create a new document.</td>
</tr>
<tr>
<td>🗂️ Open an existing label.</td>
</tr>
<tr>
<td>📁 Save current label as an *.acc file.</td>
</tr>
<tr>
<td>📚 Open the printer configuration (Add/Edit/Remove a printer).</td>
</tr>
<tr>
<td>🚤 Open the printer setup (change print parameters).</td>
</tr>
<tr>
<td>📄 Print the opened label.</td>
</tr>
<tr>
<td>🎥 Show print preview.</td>
</tr>
<tr>
<td>DELETE</td>
</tr>
<tr>
<td>Delete marked object.</td>
</tr>
</tbody>
</table>
Undo.

Redo.

Lock marked object.

Show object properties dialog.

Bring object to front.

Bring object to background.

Invert object.

Rotate object by 90° to the right.

Rotate object by 90° to the left.

---

**Text symbol bar**

It offers general functions to format text.

<table>
<thead>
<tr>
<th>Symbol meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
</tr>
<tr>
<td>i</td>
</tr>
<tr>
<td>i?</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
<tr>
<td>![Symbol]</td>
</tr>
</tbody>
</table>
Object assignment bar

It offers useful functions to assign objects of a label. To use one of these functions you have to select at least two objects.

<table>
<thead>
<tr>
<th>Symbol meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align to grid.</td>
</tr>
<tr>
<td>Align at left border.</td>
</tr>
<tr>
<td>Align at right border.</td>
</tr>
<tr>
<td>Align at bottom.</td>
</tr>
<tr>
<td>Align at top.</td>
</tr>
<tr>
<td>Set horizontal spacing.</td>
</tr>
<tr>
<td>Set vertical spacing.</td>
</tr>
<tr>
<td>Decrease horizontal distance.</td>
</tr>
<tr>
<td>Increase horizontal distance.</td>
</tr>
<tr>
<td>Decrease vertical distance.</td>
</tr>
<tr>
<td>Increase vertical distance.</td>
</tr>
<tr>
<td>Remove vertical distance.</td>
</tr>
<tr>
<td>Remove horizontal distance.</td>
</tr>
<tr>
<td>Center vertically.</td>
</tr>
<tr>
<td>Center horizontally.</td>
</tr>
</tbody>
</table>
Object properties dialogs

This dialogs show the properties of their objects of the label like for example position, dimension, dates and others. You can open the object properties dialog with a double click on an object (all but text fields). Alternative ways:

- Right click on the object and choose the option "Properties" in the popup menu.
- Mark the object and select in the menu "Object -> properties"
Click the properties symbol in the symbol bar.

Depending on the object type which you have chosen the form offers different parameters to set. Objects with the same type can be edited at the same time.

The most same properties offer the form "General". This shows the properties which have the most objects in a:design2. If you change date you can save them with OK. The dialog will be closed. With Cancel the form will closed and the changes will be discarded.

Every properties dialog has the tab "General". This offers following options:

<table>
<thead>
<tr>
<th>X and Y position</th>
<th>You can enter the x and y position in millimeters of the object. These values cannot have the value null.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height and width</td>
<td>You can enter the width and height position in millimeters of the object. These values cannot have the value null.</td>
</tr>
<tr>
<td>Object name</td>
<td>You can change the object name.</td>
</tr>
<tr>
<td>Rotation</td>
<td>You can rotate the objects around 90°, 180° and 270°. 0° means no rotation. The objects are always rotated around its center. In a multiple selection the common center is used for the rotation axis.</td>
</tr>
<tr>
<td>Object is inverted</td>
<td>Determines whether the object is transmitted inverted on the target system. Inverted means that the colors are reversed.</td>
</tr>
<tr>
<td>Object is not printable</td>
<td>Determines whether the object is transmitted on the target system. Not printable objects are displayed with gray color.</td>
</tr>
<tr>
<td>Send object as graphic</td>
<td>If you activate this checkbox this object is transmitted as graphic. This option can increase the label since need a lot of graphics memory.</td>
</tr>
</tbody>
</table>
Simple forms

Object properties of rectangle, rounded rectangle, circles and lines.

The Properties dialog offers following options for simple forms.

**Background color:**
You can enable and set a background color.

**Border:**
You can enable and set a border. The border color, border style and the border width can be changed.

**Note:**
Remember that the fill color is used only as color section. a:design2 offers only monochrome label creation.

Text

Properties of text fields

The text field properties dialog divides in the tabs **General, Fontformatting, others** and **datasource**:

**General**
See the help entry Object properties dialogs for more information.
**Font formatting**

Here you have different opportunities to format text:

<table>
<thead>
<tr>
<th>Font</th>
<th>Here are listed all printer internal installed fonts and all installed True Type fonts of the system. The number of printer internal fonts depends on the chosen printer driver and are placed at the top of the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font style</td>
<td>At choice are default, italic, bold and italic-bold.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Set the alignment of the text. At choice are left, center and right.</td>
</tr>
<tr>
<td>Font size</td>
<td>Set the size of the font in points.</td>
</tr>
</tbody>
</table>

**Others**

On this tab are settings which only exist for a text field.

<table>
<thead>
<tr>
<th>Measurement Unit</th>
<th>You can set the measure unit. At choice are points and millimeter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line spacing</td>
<td>The line spacing is for printer internal fonts and True Type fonts variable. You can enter the space for every line in percentage. The default value is the system default of line spacing.</td>
</tr>
<tr>
<td>Line break</td>
<td>Here you can enable the automatic line break.</td>
</tr>
<tr>
<td>Data source</td>
<td>You can set a fix value for the text field or refer it to a variable.</td>
</tr>
<tr>
<td>Character space</td>
<td>The character spacing is variable for True Type fonts or printer internal fonts (driver dependent). You can adjust the distance of each character in 1/12 mm. The basis for the value is the system default for line spacing.</td>
</tr>
<tr>
<td>Character width</td>
<td>The character width can be adjusted proportionally for True Type fonts or printer internal fonts in percent (driver dependent).</td>
</tr>
</tbody>
</table>
Barcodes

Properties of barcodes

The barcode properties dialog divides in four tabs: General, Barcode, Font formatting, Human readable line, Data source.

If you create a variable or counting barcode the dialog expands with one tab. See also variable barcodes, counting barcodes.

There is a barcode preview at the bottom part of the dialog. There is also a small information section which shows you whether the barcode will be created by the printer or it will be displayed as a graphical barcode.

The barcode is transferred as graphic if you:

- activate the checkbox "Always send barcode as graphic" in the tab General.
- chose a TrueType font.
- chose a human readable line alignment which the printer or the printer driver does not support
- chose a barcode which the printer does not support

Functions of the single tabs:

**General**
For more information see object properties general.

**Barcode**
On this tab you can choose the barcode type, the value and the module width. The available barcodes are flagged with two different symbols:

![Printer internal](image)
**Printer internal**
The barcode is supported as printer internal barcode and can be variable or counting.

![Graphic](image)
**Graphic**
The barcode is supported by a:design2 but not by the printer. In the transmission the barcode is converted in a graphic. You can enter the value of the coded barcode in the text field.

The input mask shows you the maximum length. For Code 128 and EAN128 you have the option to enter ASCII control characters. Under the line width point enter the module width of the thinnest line. The module width is always counted in 0.085 mm increments corresponding to 1 / 12 mm (with a resolution of 300dpi). For some barcodes it is possible to determine the relation of the lines. Therefore there is an input mask below the line width input mask if the chosen barcode supports variable module widths. As relation
ratio of the module width can be entered 2.0, 2.5 and 3.0. You can set the height of the barcode. The default value is computed from the barcode width.

**Human readable line**
Set the position and alignment of the human readable line. Please note that the bar code, if you change a parameter, is transformed into a graphic.

<table>
<thead>
<tr>
<th><strong>Position</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the position of the human readable line. You can choose between:</td>
</tr>
<tr>
<td><em>Non</em>: Disables the human readable line</td>
</tr>
<tr>
<td><em>Below</em>: Human readable line will be aligned under the bar code</td>
</tr>
<tr>
<td><em>Above</em>: Human readable line will be aligned over the bar code</td>
</tr>
<tr>
<td><em>Free line</em>: The human readable line is unbound by the barcode and can be placed as a free text field in the label. The data are still bound to the barcode.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Alignment</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the alignment of the human readable line. The alignment takes place within the human readable line position. For example the human readable line can be placed over the barcode on the left side. For the alignment are available: left, center and right</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Automatically find best font size (recommended)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>This option only affects graphic barcodes with TrueType Fonts. If it is activated the font size will be calculated by the printer driver. It is recommended to use this option to get an optimal bar code presentation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Print checksum</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>This option is available for some graphic barcodes. If it is activated the coded checksum will be displayed in the human readable line.</td>
</tr>
</tbody>
</table>

**Images**

**Images**

**Image properties**
The properties dialog for images divides in the tabs General, Image conversion, Border and scale factor and Source image info.

**General**
Unlike other objects you have the opportunity to reset the size of image in the tab General. Furthermore you can set the graphic size per cental. 100 % is the original size of the image. Another special feature is the extended section of rotation. Here you also have the opportunity to reflect the graphic horizontally or vertically. A small icon shows a preview of the settings.

**Image conversion**
On this tab you can convert a graphic in a monochrome graphic. The tab divides in following sections:

<table>
<thead>
<tr>
<th>Image conversion mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select in this section the conversion method. You can convert an image to monochrome using the color threshold value in a very contoured image. The higher the color of the threshold value is the more black pixels are generated. Floyd Steinberg is qualified for big and detailed images.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional options</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this section you determine if your image is inverted and is to be printed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preview image conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Here you can see the changes of the image. On the left side you see the source image on the right side there is the edited image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Border and scale factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this tab you can set the scale mode and use a border for your image. For the scale mode a following options available:</td>
</tr>
<tr>
<td>Keep aspect ratio: The aspect ratio is fixed.</td>
</tr>
<tr>
<td>Free scalable size: You can unfetter change the picture in its height and width.</td>
</tr>
<tr>
<td>Keep original size: The size cannot be changed.</td>
</tr>
</tbody>
</table>

**Source image info**
On this tab are displayed additional information of the source file such as resolution, size, color depth, etc. This tab is for information only.

**Tip**
To reach an optimal quality it makes sense to use a source image with the same or higher resolution as the aim system. The resolution of an image is always set in DPI. For NG and NX print systems is a graphic with a resolution of 300 dpi optimal.
Variables

Variable properties
On this tab you can set properties of a variable. It is possible to change the object name, the user prompt and the variable text:
The variable length can be changed too. Below there is a preview.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>The prompt text that would be the user see on the variable interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable value</td>
<td>The value of the variable.</td>
</tr>
<tr>
<td>Variable length</td>
<td>Here you can set the max. and min length of the variable.</td>
</tr>
<tr>
<td>Präfix and Suffix</td>
<td>Here you can set the prefix and suffix. These are putted before or after the counter value. Permits are alphanumeric characters which are not among the total length of the variable.</td>
</tr>
<tr>
<td>Pad char</td>
<td>Here you can set if a pad char will be used. You can enter the one-digit pad char in the text field. The pad char is presented to the variable if it falls below its minimum length.</td>
</tr>
</tbody>
</table>

Font and font formatting
Read more about in *Font and font formatting*.

General
See the help entry Object properties dialogs for more information.
Properties of counting fields

The property dialog divides in the tabs Counter and View.

**Counter**

Here you can set the parameters which determine the counter behavior. The tab divides in following sections:

You can change the counter name in the text field. Below there are the counter properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current value</td>
<td>The value which the counter has at the moment</td>
</tr>
<tr>
<td>Reset value</td>
<td>The value is set when the counter receives a reset or has reached its end</td>
</tr>
<tr>
<td>Step width</td>
<td>The value which is added every counting operation - can be positive or</td>
</tr>
<tr>
<td>Stop value</td>
<td>The stop value is the highest or lowest value of a counter. After reaching</td>
</tr>
<tr>
<td>Raise after x labels</td>
<td>Here you set when a counter is incremented. For example the value 2 means</td>
</tr>
<tr>
<td>Präfix and suffix</td>
<td>Here you can set the prefix and suffix. These are putted before or after</td>
</tr>
<tr>
<td>Pad char</td>
<td>Permits are alphanumeric characters which are not among the total length of</td>
</tr>
</tbody>
</table>


Here you can set if a pad char will be used. You can enter the one-digit pad char in the text field. The pad char is presented to the variable if it falls below its minimum length.

Font and font formatting
Read more about in *Font and font formatting*.

**General**
See the help entry Object properties dialogs for more information.

**Note - Creation of negative counter**

That the negative counter can reach its end the start value must be greater than the stop value. Negative start or end values are not allowed.

---

**Date fields**

**Date fields**

**Date and time properties**

**Properties of date and time fields**

The properties dialog for counter divides in Date and Date addition. This dialog allows you to create an individual date. Alternative you can choose values of a list.

**Date**

Here you can set the name of the object. You can choose between user defined and template date formats.

**User defined date**

Choose the option user defined to create your own date format. On the left side there is a list which contains all fields which the printer driver supports. A double click or the Insert button adds the field to the list on the right side. You can add ASCII characters with adding the field.
### Date templates

Choose the option templates to get a list of predefined style sheets. The fields consist of date elements which the printer has to support.

<table>
<thead>
<tr>
<th>Date addition</th>
</tr>
</thead>
<tbody>
<tr>
<td>On this tab you can manipulate the date with further parameters. You can enter an additional Offset or adjust the date codes with substitution rules.</td>
</tr>
</tbody>
</table>

### Temporal Offset

Choose the date element for which you want to enter an Offset value. The input size depends on the date element. Available are:

- Days
- Weeks
- Months
- Years

The offset is added in the preview and is immediately visible.

### Substitution rules

Activate this section to use code fields in your date. Code fields represent values in your date with one your specific characters. You can modify the weekday code, day code and year code. After the selection there is a list with input fields. Allowed is one character per element. The value range includes A-Z, a-z and 0-9. Click save to apply the values and to make them visible in the preview.

#### Important note:

Please do not forget to click "Save rules" to the save the substitution rules. This step is important because the rules are stored external.

Substitution rules are only available for NGT printers.

### Formulas
Formulas

Formula properties and how they can be adapted.

The Properties dialog for formulas is divided into tabs: **Formula expression** and **output mask**

**Formula expression**
On this tab, you determine how the formula is constructed. Also, a preview of the calculation formula shown

In formula fields already defined the variables for selection offered, also functions (mod10 (), "text"), Operators ("+", "-", "/", "/", "+", "+"), and constants. The formulas can be nested i.e. you can reference in a formula to another formula, as in the example below, in which the variable "year4" is itself a formula.

![Formula Properties](image)

- **Name**: Formel2
- **Expression**: `month & "/" & year4`
- **Result**: 12/2099

**Formula fields**

- Variables
- Functions
- Operators
- Constants
Output
In this section you can fill the following fields:

**Numeric output**
The number of decimal places and the decimal point can be specified.

**Pad char settings**
Here you can set if a pad char will be used. You can enter the one-digit pad char in the text field. The pad char is presented to the variable if it falls below its minimum length.

---

Free variables

Free variables can be used in formulas or in the document. Unlike normal variables these cannot be edited after loading the a format.

**Variable information**
The value of the variable

---

Related Topics:

Shift codes

Shift codes

Fields of this type can contain up to 4 characters that are printed in accordance with defined time intervals.
You can define shift codes that are valid only for individual days of the week or for the entire week.

Example:

Note:
This object is not available for NGT printers.

Related Topics:

Common variables
Common variables are valid for all formats in the printer. You can define up to five of these global variables in the printer and use it.

<table>
<thead>
<tr>
<th>Variable information</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of the variable</td>
</tr>
</tbody>
</table>

**Note:**
This object is not available for NGT printers.

Related Topics:

**RS-Fields**

RS-fields are used to transmit "real-time" information for quick prints. They serve as placeholders for information that is transmitted over an RS-channel (TCP/IP or RS232) to the printer. The placeholders in the print format define the position and length, which are mapped from the transmitted RS-string in the format.

In the RS-field properties you can define a test value to determine correct positions and data lengths. RS-fields can be used for barcode content and text fields.
The Audit code is a check code, which is composed of input variables and encrypted information.

The input variables are:

**Line no.** A sign used to identify an individual production line.

**Customer no.** A sign used to identify a customer.
Production facility ID A sign identifying the facility.

These variables are stored in the printer and can use the menu "Printer Setup - System variables" are set or via an input terminal.

The encrypted information is the current data (hour, minute, day, month and year). The associated code is defined as follows:

Hour = "A", "B", "C", "D", "E", "F", "G", "H", "I", "J" Hour 00 to 09
"U", "V", "W", "X" 20 to 23 hours

Minute = "AG", "AH", "AI", "AJ", "AK", "AL", "AM", "AN", "AO", "AP" Minute 00-09
"BG", "BH", "BI", "BJ", "BK", "BL", "BM", "BN", "BO", "BP", 10 to 19 minutes
"CG", "CH", "CI", "CJ", "CK", "CL", "CM", "CN", "CO", "CP", 20 to 29 minutes
"FG", "FH", "FI", "FJ", "FK", "FL", "FM", "FN", "FO", "FP" Minute 50 to 59

Day = "TO", "TZ", "ZS", "ZR", "ZQ", "ZP", "ZO", "ZN", "ZM", Day 01 to 09
"XV", "XU", "XT", "XS", "XR", "XQ", "XP", "XO", "XN", "XM", day 20 to 29
"WV", "WU" day 30-31

"J", "K", "L" from 10 to 12 month

Year = "L", "M", "N", "O", "P", "Q", "R", "S", "T", "U", Year 00-09
"V", "W", "X", "Y", "Z" is 10 to 14 years

The audit code consists of two parts (lines), which can be printed individually and connected.

The first Line is built up as follows:

Line no. (1-digit) hour (1-digit) day (2 digits) Customer no. (1-digit)
The second Line is built up as follows:

Minute (2 digits) Month (1-digit) year (1 digit) manufacturing plant id (1-digit)

**Example 1:**

Only the first line is selected, line number input A; current hour is 12, it is the 11th Day of the month; 7 customer number entered;

The corresponding expression would be: AMYU7

**Example 2:**

Both lines selected, line number input A; Current time is 12:49 clock, it is the 11th January 2013; customer number 7 entered, entered production site D:

The corresponding expression would be: AMYU7EPAYD

**Note:**
This object is not available for NGT printers.

Related Topics:

**Printer dialogs**
Description of the process to add and edit a printer

The dialog opens if you create a new printer or edit an existing printer.

Create or edit printer
Select int the menu bar "File --> Printer configuration".

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Create an printer.</td>
</tr>
<tr>
<td>Setup</td>
<td>Open the printer setup for the printer.</td>
</tr>
<tr>
<td>Change</td>
<td>You can edit the printer and change the properties.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a printer from the list.</td>
</tr>
</tbody>
</table>

Printer Setup

Setting of print parameter in the printer setup dialog

In the printer setup dialog you can set the print parameters and the check the printer state. You can open the dialog from the symbol bar by choosing "File -> Printer setup". To read and set the parameters you
need a connection to the device.
If the dialog is opened and there is no connection to the device it is only possible to adjust the parameters of speed and density. These parameters are saved in the label or in the printer driver.
The dialog divides in following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>State</strong></td>
<td>Gives a quick overview about the state and the most important parameter of the printer.</td>
</tr>
<tr>
<td><strong>Postview</strong></td>
<td>Click on &quot;Read&quot; to get an image of the current opened label of the printer. This can take a few seconds to several minutes. The successful read image can be saved as a Windows bitmap (or other file formats) on the PC.</td>
</tr>
<tr>
<td><strong>Printer settings [management password required]</strong></td>
<td>Gives you the opportunity to set the parameters related to print quality. If you are satisfied with your settings click &quot;Save&quot;.</td>
</tr>
<tr>
<td><strong>Extended / service settings [service password required]</strong></td>
<td>Allows you to set service parameters on the print device. These parameters are relevant for the correct behavior of the printer within the installation. A special feature of this setup section for NGs is to manage the fonts. This option offers the opportunity to bind in TT-Fonts in the printer.</td>
</tr>
</tbody>
</table>

**Note**

The settings of this dialog affects the print quality immediately after the send. You should only change parameters if you know the effect of them.

**Font setup**

**Font setup**

Fonts managing (only NG serie)
This dialog helps you to set the Windows TrueType Fonts as print internal font for a:design2.

The installed fonts appear in a:design2 as print internal fonts and can be used for Autocode fields.

**Structure of the dialog:**
On the left side is the list which contains the already installed fonts. On the right side are the font parameters.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nr</td>
<td>Number of the font - has to be the same like the print internal font number. Use 08 if your font is placed on the front memory space 08.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the font which is displayed in a:design2.</td>
</tr>
<tr>
<td>Display font</td>
<td>TT-font which is used in a:design2 to draw this font</td>
</tr>
</tbody>
</table>

Steps to Install a font:

1. Transfer a random TrueType Font with an external tool on a free font space of the NG.
2. Open the Font Monitoring in a:design2. Choose "Printer-Setup -> Extended -> Font Managing".
3. Enter a font number like for example 10
4. Enter a useful name for the font optimally the name of the TT-Font.
5. Choose a windows TT-Font to draw the font inside a:design2.
6. Click on 'Add' to add the font into the list of the internal fonts.
7. Click on 'Store/Save?' to apply the settings durable.
8. Your new font should be available in the Font choose of each dialog in a:design2

**Note**

The setting of the internal fonts is saved allways with the choosed printer. That means you have to repeat this process if you work with more printers even if these are the same type. To transfer TrueType Fonts use external tools like for example a:config.

---

**Program options Dialog**
About the dialog

Description of the program options dialog.

In the program options dialog you can determine global settings which apply for the whole application.

You can open this dialog from the menu point: Extras -> Options

It is divided different tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General settings</td>
<td>General programs parameter which determine the view and behavior of a:design2.</td>
</tr>
<tr>
<td>View settings</td>
<td>Settings to view specific parameters and functions of the view.</td>
</tr>
<tr>
<td>Standard value</td>
<td>You set default values and fonts in this tab.</td>
</tr>
<tr>
<td>External Programs</td>
<td>On this tab you can embed external programs in a:design2.</td>
</tr>
<tr>
<td>Passwords</td>
<td>You set the default passwords for the setup dialog.</td>
</tr>
</tbody>
</table>

Select of the above table to get detailed information about the single settings.
General settings

Setting opportunities of the tab "General settings"

Here you can set general program settings to determine the view and behavior of a:design2. The tab divides in the sections environment colors and environment settings:

Environment colors

<table>
<thead>
<tr>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the background color of the label. The color is only used for visualization and has no influence on your print (default: white).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ruler</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the background color of the ruler (default: white).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ruler text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the color of the ruler text (default: black).</td>
</tr>
</tbody>
</table>

Environment settings

<table>
<thead>
<tr>
<th>Speed / Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Not give out speed / density</td>
</tr>
<tr>
<td>- Enclose speed / density of the printer: Speed and density are fix associated with the printer and are transferred with the print.</td>
</tr>
<tr>
<td>- Enclose speed / density of the document: Speed and density are saved in the document and are transferred with the print.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Save printer model in document</th>
</tr>
</thead>
<tbody>
<tr>
<td>While opening the label the therein saved printer type is used.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Show warning message if objects are out of documents bounds</th>
</tr>
</thead>
<tbody>
<tr>
<td>The program shows a warning message if there are some objects outside the print range.</td>
</tr>
</tbody>
</table>
### Autosave document each x minute
The document is saved every x minutes. X is the value in minutes which is entered in the right text field.

### Number of displayed recent files
The menu point File shows you the recent edited labels. The here entered number is the number of displayed entries.

---

## View settings

### View settings

Setting opportunities of the tab View

Here you can set view settings to set the representation of a:desing 2. The tab divides in the sections language selection, environment view and grid:

### Language selection
Here you can choose the language which is used for the view in a:design2. If you miss a language contact your supplier.

### Environment view

#### Smooth shaded ruler
Determines whether the ruler is to be displayed with a gentle gradient.

#### Display position helper
If this option is enabled the placement help will be used if you move objects. This moves your object to an adjacent edge.

#### Show quiet zones around barcodes
Determines whether the quiet zone to be displayed by bar code. The neutral zone is a transparent area marked by the bar code that can be superimposed.

**Show warning message if quit zones overlap with other objects**

Specifies whether there is a warning message if the quiet zone of a bar code is violated by another object.

### Grid

**Enable grid on label**

Specifies whether a grid will be displayed on the label.

**Grid type**

You can choose between lines and points.

**Grid frequency**

You can set the distance of all grid elements fixed (in millimeter).

### Standard value

**Standard value**

Description of the tab to set the default value

On this tab are the default values determined which are valid in a:design2. The tab divides in the section default font and default paths:

**Default font**

Set this setting to specify what font will be used if new text or Autocode fields are created. If you activate the checkbox "Always try to use printer internal font" a:design2 try to use the font which is installed on the printer. The association between selected and printer internal font is via the font names.
## Default paths

<table>
<thead>
<tr>
<th>Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Documents</strong></td>
<td>This is the default path in which your documents will be saved and loaded. The selected path will be showed in the File open / save dialog.</td>
</tr>
<tr>
<td><strong>Print out files</strong></td>
<td>Select the path in which your files are saved if you print in file.</td>
</tr>
<tr>
<td><strong>Images</strong></td>
<td>Path which is used as default directory if you want to import an image in a:design2.</td>
</tr>
</tbody>
</table>

## External programs

### External programs

Program options: External programs

Description of the tab to embed an external application

Here you can embed Windows programs to a:design2. You find and start the embedded programs after closing this dialog in:

extras -> External programs

This menu point is only visible if you have embedded at least one program.

**Add an application**

First you need to know where your .exe program is saved. An .exe file is the executable file of a program. Click on "Add application" to choose your application. Confirm with "OK". Your application appears now in the table and the name, path and arguments are showed.

The parameter "Arguments" is optional and can be changed at any time. With a double click you can edit the arguments. The entered arguments are delivered at the start of the program.
Passwords

**Passwords**

Description of the password tab.

Description of the tab passwords

On this tab you can change passwords for a:design2. Changeable are the passwords of service and management. These passwords do you need if you want to set parameters in the printer setup.

**Change a password**

At first you have to enter the old password. Then you have to enter the new password twice and confirm.

Procedure:
1. Place your cursor in the field "old password".
2. Enter the old password and confirm.
3. The program recognizes the right password and changes the focus of the text field automatically.
4. You have to enter the new password twice.

Others

**Others**
This help entry describes the use of the page setup dialog which allows you to set the label size.

The dialog divides into two tabs:

**Printer tab**
The Printer dialog is used to display information. It offers information about the printer and the model of the opened label. Following printer properties are displayed below.

<table>
<thead>
<tr>
<th>Maximal label size</th>
<th>The maximum size of the label (length and width) in millimeter. If these dimensions are too big is it possible that the printer does not accept the label.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print speed</td>
<td>Is displayed if you set a default print speed for the label.</td>
</tr>
<tr>
<td>Print density</td>
<td>Describes the default value of the label. This is only displayed if a value is set.</td>
</tr>
</tbody>
</table>

This both default values are transferred to the printer for every transfer if the option is "use print parameter of the label" in the program settings set.

**Label tab**
Here you have the opportunity to set the label size. This can be useful if you have a fixed size specifications but this does not correspond to the maximum printable area of the printer. You can enter the new label size manually or choose between the default values of the choice box. If your entries exceed the maximum dimensions of the printer you will be notified with a message. Furthermore the label
changes color in the preview from gray to yellow. To apply the settings close the dialog by clicking "OK".

## Protect document

### Opportunities for limiting access of the document

:y:design2 you can control the access of your document. This option is called Protect document and you find it in Extras -> Protect document.

In the dialog you can choose between the following document protection options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The document does not receive any protection.</td>
</tr>
<tr>
<td>Full protection</td>
<td>The document only can be edited after entering the password.</td>
</tr>
<tr>
<td>Print and view</td>
<td>The user can regard and print the document without entering the password.</td>
</tr>
<tr>
<td>Fill variables</td>
<td>The user can regard, print and set the variables values of the document.</td>
</tr>
</tbody>
</table>

After you have chosen a protection option please enter a password twice. With Apply protection the dialog will be closed and you will get a message.
Variable form

Changing of variable values

The variables input form is displayed before the print starts. There you can enter variable values. Alternative you can open this form when you edit your label. You find this function in the menu item: View -> Show variables form

In this form you can enter single values of a counter too. The fields are displayed automatically if there is an Autocode in the label.

Note

The rules above also apply to variables and counting barcodes.

Document regions

Document regions are used to divide a large print image into several areas. These regions are successively printed during each print cycle.

You can enter the dialog by clicking Menu->Tools->Document regions.

A region may not be longer than the maximum printable length of the selected printer (IM mode)

Add regions
You can add new regions by specifying the beginning and the end of a region.

**Edit, Delete regions**

You can change, delete or scale regions. It is also possible to delete all created regions at once. All objects in the document will be preserved.

**Optimize regions**

The beginning and the end of all created regions can be optimized according to the objects.

Document regions are highlighted gray.

Note: this functionality is limited to the NG-printer series.

---

**Database functionality**

This help entry describes the use of databases, spreadsheets or other data sources.

A: design2 is able to select data from a data source by the use of a key variable. For this purpose it is necessary to create a database connection in the document browser.

**A key variable is necessary to use this functionality. If no variable is found in the document, a dialog appears which allows you to define such a variable.**

**Note:**

This functionality is only available in the registered version.

**Path**

Select your data source. Supported data sources are *.mdb, *.accdb (Access) *.xls,.xlsx (Excel), SQL Server, ODBC

**Select table**

If there are several tables in the database, you can specify the tables you want to work with.

**Existing fields / Used fields**

Push available fields to used fields by clicking the arrow buttons.

**Key field / key variable**

Select a key field from all available database fields and assign this key field to a variable in the document.
The selection is done by selecting the appropriate drop-down box.

After leaving the dialog, the selected fields appear in the document browser. Now you can continue to process these fields by dragging a field into the document. If the value of the key variable changes, all database fields in the document are updated.

Wizards

Barcode Wizard

Create GS1 compliant datamatrix barcodes and GS1-128 barcodes

For example you can create a valid GS1 code with a standard GTIN, a lot number and an expiration date.

Note

This functionality is only available in the registered version
Global Trade Item Number (GTIN) is an identifier for trade items developed by GS1 (comprised among others of the former EAN International and Uniform Code Council.) Such identifiers are used to look up product information in a database (often by reading the number through a bar code scanner pointed at an actual product) which may belong to a retailer, manufacturer, collector, researcher, or other entity. The uniqueness and universality of the identifier is useful in establishing which product in one database corresponds to which product in another database, especially across organizational boundaries.

PDF Wizard

With the help of the PDF Wizard, you can convert a PDF file to a bitmap and import this as an a:design2 graphic object.

Note

This functionality is only available in the registered version

For this conversion a valid Ghostscript installation is needed. You may be able to obtain Ghostscript from the Internet.

Printing labels

Index
Functions of the print dialog

The print dialog is displayed immediately before the label transfer. Printing starts by clicking the print icon in the symbol bar. Also you can start the label transfer in the menu bar "File -> Print". The Print dialog offers the following options:

**Printer selection:**
Select the target printing system for the label. As default printer will be showed the one which the label was created for.

**Print quantity:**
Number of copies. Enter the value null to set the number of copies to infinity.

**File print:**
Select this option button to redirect the output to a file. After you enable this option and then click Print, a file selection box where you can select the destination file.

**Advanced:**
Wait after transfer to printer Answer:
Check this option if you want a:design2 waits for a confirmation of the printer before it transfers the label. If this option is enabled the transfer takes longer but you can determine whether the label has been transferred successfully or not.

**Setup button:**
This button takes you to the Printer Setup of the selected printer.
Autocodes behavior

While printing labels please regard following hints:

Variables:
Variable fields are refreshed immediately after the transfer of the label. It does not matter whether you print to file or print to a print system. If you change a variable value it will be applied to the label immediately. The same takes effect to barcodes.

Counter:
Counting Fields will be increased after each transmission to the step width. If you entered a counting step of > 1 the counter will be increased when the number of label transfers is equal to the entered value. For example: If the counting step is 2 the counter will be increased after every second label transfer. After each increase a barcode will be new coded and refreshed.

Driver selection

The dialog opens if you create a new printer or edit an existing printer.

Selection of the printer driver:
On the left side of the dialog you can select the printer drivers which are arranged in a tree structure of the manufacturers. Double click on a manufacturer to show all supported printer model.

Set the connection settings:
On the right you can choose between serial or network based communication. If you decide to use network connection you have to specify IP and port of your printer. The default port of your printer is automatically showed. By using the serial communication you have to set all serial connection settings. If you are unsure with the setting of the serial connection settings consult your printer manual for the settings.

Windows driver

The use of windows printer drivers

What to consider when using Windows printer drivers

What to consider when using Windows printer drivers:

Label size:
a:design2 uses always the default size of the windows driver. In general is this DIN A4.

Printer setup:
The displayed printer setup is direct from the Windows printer driver. Settings made there also affect other applications.

Autocodes:
Autocodes are not compatible with Windows printer driver. You can create fields but they are transferred as graphic.

Barcodes:
You can use any barcode of a:design2. But this are transferred as graphic.

Colorful labels:
The print of colorful labels is not possible with a Windows printer driver.
**Printer driver binding:**
A printer which is already installed in Windows has to be chosen in a:design2. See also printer configuration.
For further more information or questions about a:design2 please contact:

**Allen Coding GmbH**
Friedrich-Bergius-Ring 30
97076 Würzburg
Germany
E-Mail: support@allencoding.com
Web: [http://www.allencoding.com](http://www.allencoding.com)

Tel.: +49 (0)931-25076-0
Fax: +49 (0)931-25076-50
Copyright

Copyright notes

This program is using the zint barcode engine and Magick.NET

Zint Backend License

libzint - the open source barcode library
Copyright (C) 2009 Robin Stuart <robin@zint.org.uk>

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of the project nor the names of its contributors
   may be used to endorse or promote products derived from this software
   without specific prior written permission.

   THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
   ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
   IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
   ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE
   FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
   DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
   OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
   HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
   LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
   OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
   SUCH DAMAGE.

Magick.NET

Apache License 2.0

Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

   "License" shall mean the terms and conditions for use, reproduction,
   and distribution as defined by Sections 1 through 9 of this document.

   "Licensor" shall mean the copyright owner or entity authorized by
   the copyright owner that is granting the License.

   "Legal Entity" shall mean the union of the acting entity and all
   other entities that control, are controlled by, or are under common
   control with that entity. For the purposes of this definition,
   "control" means (i) the power, direct or indirect, to cause the
   direction or management of such entity, whether by contract or
   otherwise, or (ii) ownership of fifty percent (50%) or more of the
   outstanding shares, or (iii) beneficial ownership of such entity.

   "You" (or "Your") shall mean an individual or Legal Entity
   exercising permissions granted by this License.

   "Source" form shall mean the preferred form for making modifications,
   including but not limited to software source code, documentation
   source, and configuration files.

   "Object" form shall mean any form resulting from mechanical
   transformation or translation of a Source form, including but
   not limited to compiled object code, generated documentation,
   and conversions to other media types.

   "Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS